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Self Serve Recording Navigation
• Use the panel on the left to navigate between features and demonstrations
• Both sections and features are labeled for your convenience 
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21R1 Key Dates
Dates Event

March 22 (all PODs) Pre-release vaults available

March 22 – 26 Validation package available on VeevaDocs
March 22: System Release Memo
March 23: Compliance Documents
March 26: Executed OQs

March 30 EU PromoMats Q&A Session
https://veeva.zoom.us/webinar/register/WN_Pt-LFLjZTmKPaLoM_DQ89w
NA PromoMats Q&A Session
https://veeva.zoom.us/webinar/register/WN_PEiPpbeiQo2UOPCtG_BaMw

March 31 Global MedComms Q&A Session
https://veeva.zoom.us/webinar/register/WN_wrqCa8ZhQhCfh73TfcoM_Q

April 8 Developer Release
https://veeva.zoom.us/webinar/register/WN_D4x95U_lRYS4kLGb7dqeoQ

April 9 Release to all limited release PODs and PODs VV1-2, VV1-1055, VV1-1065, VV1-1088, VV1-1121
Vault File Manager does not release at this time, and instead releases with the general release PODs

April 16 Release to all general release PODs

https://veeva.zoom.us/webinar/register/WN_Pt-LFLjZTmKPaLoM_DQ89w
https://veeva.zoom.us/webinar/register/WN_PEiPpbeiQo2UOPCtG_BaMw
https://veeva.zoom.us/webinar/register/WN_wrqCa8ZhQhCfh73TfcoM_Q
https://veeva.zoom.us/webinar/register/WN_D4x95U_lRYS4kLGb7dqeoQ


Announcements
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June 10, 2021

Save the date

A single day event that will connect 
you with the people and ideas you 

care about most.

Every hour the agenda alternates 
between large group sessions and 

small interactive discussions.

https://www.addevent.com/event/AD6115182


21R2: Looking Ahead
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Vault User Interface Enhancements
• Pre-announcing several exciting planned features to enhance usability with an 

updated look and feel
− Vault UI Styling - modern look and feel
− Action Bar - easily access frequently used actions on a record or document
− Doc Info Page Enhancements - improved usability in managing document and annotation
− Notification Badge - view notifications from anywhere in Vault
− Action Menu Button Change - update to a more intuitive icon

• These enhancements are planned as Auto-on immediately with the 21R2 upgrade 
− Customers may choose to turn OFF the UI changes after 21R2 (August 2021) in order to prepare 

training materials
− Changes become permanent, auto-ON, for all vaults with 21R3 (December 2021)

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.

21R2 21R3

Auto-ONDefault ON / Option OFF 
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Vault User Interface Enhancements

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.

Initial Design – Subject to Change
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21R2: Office Online Support

Users can check back in 
until 21R3

Collaborative Authoring 
replaces Office Online

21R2 Office Online 
Support stops



Moving to 
One Workflow
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Document Workflow Envelope/MDW Object Workflow

Moving to One Workflow
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2021 Timeline

21R3

• You can still edit legacy workflows

21R1

• You can still edit legacy workflows
• You can still create and copy legacy 

workflows

21R2

• You can still edit legacy workflows
• You can still create and copy legacy 

workflows

• New template workflows for 
Component and Reference 
documents available for optional use

• Old workflow tab renamed “Legacy 
Workflow”

• MDW workflow renamed ‘Document 
Workflow’

• New template workflows for 
Material documents available for 
optional use

• One Workflow tab to create 
Workflows

• No Create or Copy for Legacy 
Workflows

Projects in-flight to think about building workflows in One Workflow

Important Disclosure: The following outlines Veeva’s current product direction. These plans may change as we learn more



eCTD Compliance Package Generation
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New eCTD Requirements
By June 2021, organizations must submit 
electronically to the FDA for the following 
submissions:

− Post Marketing submissions of promotional 
materials using Form FDA 2253

− Pre Clearance of promotional materials for 
accelerated approval products

To assist customers in adhering to the final 
guidance Veeva has released an enhanced eCTD 
Compliance Package for Vault PromoMats in the 
20R3 release.
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eCTD Compliance Package: 
Generate Correspondence Letter

• Overview
− This feature adds the ability to automatically 

create a Correspondence Letter when 
generating a Pre-Clearance Compliance 
Package in vaults with eCTD Compliance 
Package Generation enabled

− The Correspondence Letter contains 
information that must be submitted to the 
FDA, preventing users from manually 
creating the letter

• Considerations
− You can create multiple Correspondence 

Letter templates, allowing users to select the 
applicable letter when generating the Pre-
Clearance Compliance Package

• Learn more about eCTD Compliance 
Packages

http://vaulthelp2.vod309.com/wordpress/applications/promotional-materials-edition/configuring-the-ectd-compliance-package/
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eCTD Compliance Package: 
Generate Correspondence Letter

• Configuration
− Download the Correspondence Letter 

template
− Update the document template with your 

company’s information
• Note that you need to ensure the Promotional 

Material Information document field is not 
hidden on the Correspondence Letter. Hiding 
this document field prevents Vault from 
populating the Material Type, Material ID, 
and Material Description and Product fields on 
the Correspondence Letter

− In Vault, navigate to Business 
Admin > Documents & Binder > eCTD 
Submission Ready Documents

− Click Create and select Document Template
− Select the Basic Document Template type
− Enter a Correspondence Letter label
− Click Upload File and select the 

Correspondence Letter template
− Click Save

http://vaulthelp2.vod309.com/wordpress/wp-content/uploads/eCTD_Correspondence_Letter_Template.docx
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eCTD Compliance Package: 
Relative PDF Links Work in PromoMats

• Overview
− Relative PDF links within compliance packages can now be opened in PromoMats

• Users no longer need to export the compliance package to open the links

• Considerations
− The reference or PI document will open in a pop-up viewer when the Relative PDF link is clicked
− You must have the new (20R3) eCTD Compliance Package generation configured and clicked ‘Yes’ 

to include Linked References
− Relative PDF links can still be opened after exporting the compliance package

• Use Case
− Users may want to test 

the Relative PDF link 
destinations prior to 
exporting the package

Clicking on the Relative PDF link in the 
annotated version of the promotional material 

will open the reference/PI document in 
PromoMats to the exact destination



Auto-Claims Linking
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Auto Claims Linking: Prevent Duplicate Records
• Overview

− This enhancement prevents users from saving 
new or updated Claim record if it is an exact 
duplicate of an existing record

− Duplicate is defined as a Claim record with the 
same Match Text and the same matching fields 
• For example: the same Product, Country, and 

Match Text
− On detection of a duplicate, an error is 

displayed, and you are not able to save the 
Claim Record
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Auto Claims Linking: Prevent Duplicate Records
• Considerations

− Wildcards are treated as plain text during validation
• “Trust Cholecap” and “Trust Chole[*]” are not duplicates
• “Trust Cholecap®” and “Trust Cholecap” are not duplicates

− Excluded characters, trailing periods, and exclamation marks are ignored by duplicate detection
• “Trust Cholecap®” and “Trust Cholecap” are duplicates
• “Trust Cholecap.” and “Trust Cholecap” are duplicates
• “Trust Cholecap!” and “Trust Cholecap” are duplicates

− Blank fields are not considered a match for duplicate validation
− References, non-matching fields and match text variations are ignored for duplication checks
− Validation is enforced when Claim record is created through:

• Use Case
− Many customers are beginning to use Claims globally and are either copying Claims or creating 

Claims from existing Promotional Materials with “Get Link Annotation Data”. This increases the 
chances of duplicate Claims being created

User Interface API Bulk Action Vault Loader Copying an existing 
Record
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Auto Claims Linking: 
Preview & Create Anchor from Claims

• Overview
− Users can create new anchors within 

existing reference documents, which 
streamlines Claim record creation

− Aligns creation of Claims to manual 
Referencing experience

− Permissions
• User requires View Content permission on 

target Reference document
• User requires Create Anchor permission

• Users without Create Anchor can select 
existing Anchors

• Considerations
− Creation of anchor takes place in a mini-

browser window
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Auto Claims Linking: 
Display Match Text Variation in Info Card

• Overview
− When a Match Text Variation is used to match a Claim record to a document, Vault will now 

display the Match Text Variation record ID alongside of the parent Claim ID in the footer of 
Suggested, Approved, and Auto Link annotation info cards 

• Considerations
− Additional information about the Match Text Variation can be viewed by hovering over the ID or 

by clicking the ID to open the record detail page in a mini-browser window

Additional information 
is displayed when the 

ID is hovered over

Match Text Variation 
record ID
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Auto Claims Linking: 
Configurable Columns in Select Claims Dialog

• Overview
− Any Claim object field configured to appear in the Claim hovercard will now also be displayed as a 

column in the Select Claim dialog that opens when users are selecting records to manually create 
Claim Links on documents

• Considerations
− To configure fields to appear in the Claim hovercard, Admins need to check the ’Display in default 

lists and hovercards’ on the Claim or Match Text Variation Object field

Fields that appear in the hovercard 
will now also appear in the Search 

Claim dialog



Auto-On: 
Digital Asset Management
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Increase to Maximum Source File Size for Videos
• Overview

− The maximum source file size for video files has been increased to 4GB from the previous 2GB 
limit for video source files

− Video files up to 4GB will also be rendered, allowing for review and annotation in Vault

Video Files up to 4GB can be 
upload through the UI

Annotate videos up to 4GB

Playback video files up to 
4GB
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Video Playback Speed Controller
• Overview

− Users can now modify the playback speed of videos by clicking the (+) icon to speed up by one 
increment, or the (-) icon to slow down by one increment, within a set of defined increments

− Vault displays the current playback speed next to the speedometer icon in the control bar
− The defined speeds include:

• 0.25x 
• 0.5x
• 0.75x
• 1x (default)
• 1.25x
• 1.5x
• 2x

• Considerations
− Modified speed is not automatically applied on the next video
− This is also applicable to viewing video files in Portal
− Speed control does not apply for audio files
− Speed control is not supported for Android devices
− Only for videos that render within Vault for video annotation

Use the (+) & (-) icons to speed up or 
slow down the video playback speed
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Video Review: Bring Forward Annotations
• Overview

− With this release, users can bring forward annotations on video documents
− Users can also enter Move mode to edit the time signature of annotations

• Considerations
− All supported annotation types can be brought forward (notes and links)
− Placement based on coordinates and timestamp only
− If timestamp doesn’t exist, the annotation is placed at 00:00 with “alert” icon
− Annotations between video and non-video renditions, such as storyboards, cannot be brought forward

• Learn more about Annotating Videos

http://vaulthelp2.vod309.com/wordpress/user-help/document-collaboration-markup/annotating-videos/
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Audio & Video Renditions for CrossLinks
• Overview

− In 21R1, CrossLinks that point to Audio or Video Documents in other Vaults will now pull through 
those renditions, allowing users to easily review CrossLinks where the source document is an 
audio or video file

• Considerations
− You can annotate Video Documents if binding rule is set

to Specific Document Version
− You can not annotate Audio Documents 

CrossLink renders the Video Rendition
Source Document is a Video file
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Upload Large Size Asset Renditions using 
Vault File Manager

• Overview
− The UI for the Add Rendition modal in Vault has been updated so that you can now select the 

Large Size Asset rendition type and upload files between 1GB – 100GB using Vault File Manager

Users with the Check Out to File 
Manager permission will now be 

able to upload large size assets up 
to 100GB using Vault File Manager

The Large Size Asset rendition type 
is available when included on the 

document type
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Upload Large Size Asset Renditions using 
Vault File Manager

• Considerations:
− Vault File Manager is only available on Windows OS 

• Use Case
− Organizations no longer need to use the ”FTP Inbox” functionality or the FTP Client to upload 

large size assets like high resolution videos. End users can easily upload files larger than 1GB and 
up to 100GB into Vault

The destination document 
number is clearly displayed

Drag and Drop one or more 
Large files (1GB – 100GB) 
into the New Upload tab

When the finalizing 
asynchronous upload is 
complete the Large Size  

Asset is added to the 
Rendition section



Auto-On: Working with Documents
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Annotate Filters: Enhancements
• Overview

− Moves filters to sidebar
− Adds Author and Tag (multi-select)
− Reorganizes and relabels some filters
− Enhances filter useability by providing more options
− Enhances value of annotation tagging

• Considerations
− In-use sections are expanded dynamically
− Most settings saved as user preference except for 

Author and Tag
− My Annotations / Other Annotations replaced by Author
− Reply Authors not included in Author list
− Cannot simultaneously view Filters, Bookmarks, 

Destinations (use same sidebar)
− More Link filters when Auto Claims Linking enabled 

(Suggested, Approved, Auto, Claim) 
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Document Owner Can Undo Checkout 
for All Checkout Types

• Overview
− Document Owners are now able to undo checkout 

sessions on any document where the Owner role has 
Edit Document state and role permission

• Considerations
− The Owner must have a document role with the Edit 

Document permission on the checked-out document

• Use Case
− The Owner of a document needs to route their 

document while another user has it checked out
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Show Document Number in Cart
• Overview

− Vault  will now display the document number for each document in your Cart, which helps to 
differentiate between documents with similar names

• Considerations
− For multi-document workflows from the Cart if there is an issue adding documents to the 

workflow, the warning dialog presents the document numbers that are causing issues

The Document Number 
has been added
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Template Search Enhancements
• Overview

− When creating documents from templates, the field where users select a template is now a 
type-ahead field 

− This allows users to find templates quicker in Vaults where there are many templates available 
for the selected document type

When choosing a document type from the Create Document 
from Template Step 1, Vault will only populate Document 

Types that contain templates
After selecting the available document type, the associated 

templates are autogenerated as you attempt to type



Auto-On: Searching & Filtering
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Contains Operator for Advanced Filtering
• Overview

− Contains operator available for filtering Picklist and Object fields in Library View, making user 
navigation quicker

Contains now available

Shows all results 
with “United” in 

the Country name
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Document Inbox Improvements
• Overview

− The Document Inbox has received several improvements:

3) An updated Tabular View UI 
with select row check box

1) The Document Inbox View will 
ALWAYS be available for users 

with the Create permission on at 
least one document type

2) The Classify Action is 
renamed to Complete

4) Drag  & drop up to 250 
documents directly into the 
document Inbox and track 

file upload progress 



Auto-On: Reporting
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New Auto-On Report Enhancements

Additional Functions in Report 
Date Filters

Exports of Icon Fields in Reports 
Return Alternative Text

Improved Handling of Hyperlinks in 
Excel Exports

• This feature provides support for the use 
of If() functions and several other logical 
operators, including =and !=, to report 
date filters

• Help users narrow the scope of their 
report even further through utilizing 
additional functions

• This feature makes it easier for a user to 
identify Icon-type Formula fields with 
alterative text instead of the full formula 
when making exports

• Provides users with an easier way of 
understanding Icon-type formula Fields in 
reports with text from an export

• With this new feature, report exports to 
Microsoft Excel™ will give you the ability 
to have more than 65,000 links improving 
the previous 65,000-hyperlink limit with 
Excel 

• User will not have to use the following 
workarounds when their exports contains 
65,000 plus hyperlinks: 

− Export to CSV or TXT; the links are 
included as plain text in a separate 
column

− Add filters to the report to reduce the 
number of records to reduce the 
number of hyperlinks in the Excel file 
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Formula Fields in Document Reports
• Overview

− This feature allows users to define formula 
fields directly in their document reports

− Users have access to a rich set of functions 
and operators to analyze and format their 
document data

− This feature empowers customers to 
perform calculations as required by the 
business, without having to change the 
data model to support this

− Formula fields can then be used as 
filters, added as columns, or used as 
row groupings

• Use Case 
− Use this to track the time between key 

stages in your promotional content 
based on key date information
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Increase Maximum Number of Objects for 
Standard Report Type

• Overview
− This feature increases the default maximum number of objects that can be included in a 

standard report type from five (5) to ten (10)
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Enhanced Support for Rich Text & 
Long Text in Reports

• Overview
− This feature allows users to export the full text of Rich Text and Long Text fields from reports 
− Users can:

• Export Rich Text Fields
• Can now view the full text within the context of the report

User can choose full 
content or plain text
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Column Sorting in Reports: Consistent with Library
• Overview

− In order to make column sorting in Reports consistent with how the Library and other lists 
within Vault work, it has been updated so that:
• It is now case insensitive (text beginning with the same characters appear next to each other regardless 

of capitalization)
• Blank cells will appear at the end of the list when sorted in ascending order as they currently do for 

descending results

When sorting, blank cells 
will always appear at the 
end of the resulting list
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• Overview
− Admins can now define binder reports

and document relationship reports as 
report views and Join binder reports and 
document relationship reports to other 
report types, including object, document, 
and workflow reports

• Considerations
− Not yet supported:

• Binder Section with Document 
• Binder Section with Document and Binder

• Use Case
− Users may need to identify which documents are not included in binders. To see this, they 

could create a Multi-Pass report that shows the relevant documents and all binders with 
documents, which will allow them to determine which documents are not in a binder

• Learn more about Multi-Pass reports

Multi-Pass Reports Support Binders & 
Document Relationships

http://vaulthelp2.vod309.com/wordpress/admin-user-help/multi-pass-reporting/


Configurable
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Link Annotations to Permalinks

Once enabled in Vault, a 
Permalink option will be 

available when adding links

• Overview
− This feature allows users to link annotations to permalink targets which will keep your link annotations 

with the most recent version of that specific permalink target (subject to user permissions)
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• Considerations
− Creates distinct version-less Linked Document relationships
− Link annotations auto-update
− Requires the same permissions as linking to documents and anchors
− Treated as Manual Links in filters and export (PDF with Annotations, Export Annotations)
− A single permalink annotation can be linked to multiple targets

Link Annotations to Permalinks

Multiple  target permalinks 
can be selected when 

adding targets
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• Configuration
− Admin > Settings > General Settings > Documents > Enable linking to permalinks

Link Annotations to Permalinks

Enable linking 
to permalinks
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Expanded Search
• Overview

− Users can search collections of objects when executing a single search within Vault, allowing users to: 
• Expand their search from a single object in a custom tab to all objects in the collection
• Filter and sort the search results for each of the objects independently to build a refined view of records across the 

collection
• More easily locate data and information they are searching for without having to be precise against which object 

record they are searching
− Collections, denoted with a square plus icon         , are nested below related parent tabs
− Vault displays your search results in the expanded search results view
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Expanded Search
• Considerations

− Admins can create up to 20 collections
− From custom tabs, Vault displays any available collections in the Expand Search section 
− Users can expand both Basic Searches and Advanced Searches

• Use Case
− Users can use this to 

search across all Auto 
Claim Records and 
Match Text Variations 
for a search term with 
a single search
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Expanded Search
• Configuration

− Navigate to Admin > Settings > Search Settings
− Click Create in the Search Collections section of the page
− Enter a Label and a Name for the collection. The Label should reflect a specific business process 

of your organization so that users know what to select when expanding their search. 
The Label will also appear as the title of the search results page when users execute an expanded 
search against the collection
• Optional: Enter a Description. The Description appears to users when they click on the question mark (?) icon 

next to the title of the expanded search results page
− Click on the Object button in the Collection section to add an object to the collection
− Select an Object

• Optional: If available, select Object Types to filter on
• Optional: If available, you can set the option to allow expanded 

searches on the collection in the related tab
− Click Add to add the object to the collection

• Optional: Add additional objects to the collection. You can add 15 
objects to a collection

− Click Save to save the collection
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PDF/A Viewable Renditions
• Overview

− This feature has provided Vault with the ability to support PDF/A viewable renditions 
• PDF/A is a widely-adopted ISO-standardized (190005) Portable Document Format specialized for use in the 

archiving and long-term preservation of electronic documents. PDF/A differs from PDF by prohibiting features 
unsuitable for long-term archiving, such as font linking and encryption

• Considerations
− When PDF/A renditions are enabled Vault wide, Vault does not generate standard PDF renditions
− Alternatively, A rendition profile can be created in order to limit PDF/A rendition generation to 

specific documents
• You must assign the ‘Rendition Profile’ shared document field to any specific document type, subtype, or 

classification for which you want the option to generate a PDF/A-compliant viewable rendition to be available
− Vault does not automatically re-render existing viewable renditions when you enable PDF/A 

compliant renditions
When enabled for use on specific 
documents, users will select the 

Rendition Profile the document will use

Viewable Rendition will 
be identified as PDF/A
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PDF/A Viewable Renditions
• Configuration

− To Enable Vault wide: Admin > Settings > Rendition Settings > PDF Format > Generate Pdf/A-1b 
Compliant Rendition

− Rendition Profile to use on specific documents: Admin > Configuration > Rendition Profiles > Create
• Enable ‘Rendition Profile’ shared document field to any specific document type, subtype, or classification for which 

you want the option to generate a PDF/A-compliant viewable rendition to be available

Vault wide: Checkbox in 
Admin to enable PDF/A Rendition Profile: Checkbox 

to define PDF Format



Modular Content
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Our Definition of Modular Content

Instead of creating each asset from scratch A modular approach relies on pre-approved 
content blocks, or modules, that teams can quickly 

and easily recombine into polished assets
Approved Email

Social

Mass Email

CLM

Web

Modular content represents a dramatic shift in how teams draft, review, and distribute content

Approved Email

Social

Mass Email

CLM

Web
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Our Definition of Modular Content
Modular content represents a dramatic shift in how teams draft, review, and distribute content

Create relevant 
content faster

Increase 
content re-use

Create compliant 
omnichannel 

content at scale

Dramatically faster 
MLR



Admin
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Enhancements to API Limits
• Overview

− As of 21R1, the Vault API will no longer enforce daily API call limits
− The Vault API will no longer return Daily Limit HTTP headers in responses when using API version 

21.1 or greater
− Past versions of the Vault API (20.3 and older) will return the following static values:

• X-VaultAPI-DailyLimitRemaining: 999,999
• X-VaultAPI-DailyLimit: 999,999

• Considerations
− Vault will still enforce the Burst API Limit
− When a Vault reaches the Burst Limit, each subsequent API call will be delayed 500ms until the 

burst period has expired

Only the Burst API Limit is 
displayed in the Admin Settings
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Atomic Security for Document Lifecycles
Enablement Change

• Overview
− Atomic Security for document lifecycles will now be available for all Vaults, without having to 

request it from Support

• Considerations
− This enablement change does not affect end-users of Vault
− Workflow Initiators and users in the Coordinator role will continue to have automatic access to 

active workflow actions

Atomic Security allows Admins more 
granular control, based on lifecycle state and 
role, over who can perform:
• Specific lifecycle user actions, such as 

changing a document’s state and starting 
a workflow
• Active workflow actions, such as Cancel 

Workflow and Add Participant Actions can be hidden from 
users who should not be 

able to perform them

Atomic Security allows Admins more 
granular control, based on lifecycle state and 
role, over who can perform:
• Specific lifecycle user actions, such as 

changing a document’s state and starting 
a workflow
• Active workflow actions, such as Cancel 

Workflow and Add Participant
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Enhanced User Profile Page
• Overview

− The User Profile page has an 
updated layout and added 
customizability which allows 
Admins to configure the User 
Profile page to:
• Show or hide fields
• Give users the ability to 

update certain User fields

• Use Case
− Admins can allow their users to 

set task notification preferences 
to either receive a notification 
every time a workflow task is 
assigned or to get a daily 
summary notification
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Enhanced User Profile Page
• Considerations

− The new User Profile page is based on 
the User object

− Vault now has a new application permission for 
users: View User Profile
• By default, all users have this permission to maintain 

existing behavior
• Admins now can remove this permission and hide the 

User Profile page, if needed

• Configuration
− Admin > Configuration > Pages > User Profile Page 

> User Profile Layout
− Select either General Information or Notification 

and Email Preferences
− Add or remove items from either 

the Fields or Read-Only Fields boxes
• Only fields that have been added to the fields box can 

then be added to the read only box 
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Role Permissions
• Overview

− This new feature allows Admins to grant individual permission sets to users outside of security 
profiles by assigning User Roles

• Considerations
− Access can differ based on specific application role assignment, which, for example, might be 

determined by additional responsibilities or training level
− There will be a new VOF join object user_role_sys (up to 15 active user role assignments)

• Use Case
− This feature can be used to 

simplify complex security 
profile configurations 

Users can be added to 
specific permission sets 
within application roles
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Role Permissions
• Configuration

− Admin > Configuration > Objects > User > Page Layouts > User Detail Page Layout > Add Section > 
Related Object > User Role Add a related object section for the User Role object to 
the User object detail page layout
• Optional: To allow access to User object records outside of Admin > Users & Groups > Vault Users, 

select Display in Business Admin menu in the User object configuration, or add a User custom object tab

Add a related object section for 
the User Role object to 

the User object detail page layout
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Prevent Document Add in Related 
Document Section

• Overview
− With this feature, Admins now can control whether users can add new related documents 

directly in the Related Document section on an object record

• Use Case
− Organizations can leverage this feature to have more granular control over how users create and 

manage relationships between an object record and it’s related documents

The Add document button has 
been removed from the record’s 

Related Document section 
preventing users from relating new 
documents from the object record

Enabling this feature forces users to 
manage/edit the document object 

relationship using the object 
reference field on the Document  
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Prevent Document Add in Related 
Document Section

• Configuration
− Admin > Configuration > Objects > {Object} > Page Layouts > {Layout} > Edit Related Document 

Section > Enable Prevent Document Addition

Enabling this feature removes the 
Add Document Button from the 

Related Document Section
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Related Document Section Filters
• Overview

− Admins can configure Criteria VQL filters on Related Document sections 
in object page layouts to restrict the documents that users can add

− Admins can use fields on the related document and on the current 
record to construct query conditions and filter the list of documents 
shown in the related document section

− Allows users to select content that is relevant to the object record 
more quickly

• Considerations
− Users must have Read permission on all fields used in the filter in order 

to access the relevant related documents section on object records

• Use Case 
− Can be used on any object record to apply restrictions via VQL
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Enabled Field for Document Type Detail Object
• Overview

− The Document Type Detail object contains a new field (called ‘Enabled’) that represents whether 
the corresponding doc type is Active or Inactive

− The addition of this field allows customers to configure the Template Document Type field with a 
reference constraint (enabled__v = ‘true’) to only show Active doc types, sub-types, or classification

The (enabled__v = ‘true’) filter 
expression will display only Active 

status document type, subtype, 
or classification

Users will only be able to select 
values that have an Active status. 

Inactive status values are not 
available for selection. 
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Admin Field Layout Matches Doc Info
• Overview

− The Field Layout on the Doc Info Panel will now always match the respective order of the Field 
Layout configuration on the Admin tab, even if an Admin imports a new section via Configuration 
Migration or if Veeva provisions a new section

• Considerations
− Current Field Layout in the UI may change if there are differences from what is configured on the 

Admin Field Layout

Note the Lifecycle Details and 
Portal Details sections are not 

applicable to this document type



72Copyright © Veeva Systems 2021

Enhancements to Document Name Inheritance
• Overview

− The Document Name Format and Document Name Generation have been updated to clearly 
indicate whether the Document Name Format or the Document Name Generation is being inherited 
by the base document

• Considerations
− Document Name Regeneration only appears if the Document Name Format is either ‘Custom’ or 

‘Inherited’, but only where the inherited format is Custom
− The new ‘Document Name Regeneration’ section will indicate if it is inherited from the parent or not

When using a ‘Custom Document 
Name Format’ the 3 options 

under ‘Document Name 
Regeneration’ will appear

BEFORE AFTER
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Document Auto-Naming: Excluded Characters
• Overview

− Vault will now exclude the curly bracket characters when auto-naming documents, as these can 
cause issues when resolving document field tokens

• Considerations
− Previously, Vault would exclude any content inside curly brackets when using Auto-Naming
− If necessary, we recommend using (parentheses) or [square brackets] instead

• Learn more about document auto-naming 

http://vaulthelp2.vod309.com/wordpress/admin-user-help/fields-objects/managing-document-name-defaulting/
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Document ID in Document Audit Exports

The Document Audit History 
CSV file pictured contains 

the new column

• Overview
− With this release, document audit exports to CSV will contain a Document ID column, 

decreasing the time needed to find specific document information in document audit exports 
and allowing users to quickly find the corresponding documents in Vault using the Document ID 
column
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Document ID in Document Audit Exports
• Considerations

− The following permissions affect your access to audit trails:
• To view the audit trails, you need the Application: Audit Trail: View permission
• To export audit trails, you need the Application: Audit Trail: Export permission
• For the document audit trail, you must be in a role on the document that grants the View Document permission

Click here to download the CSV 
file with the new ID column

This is where you can view 
Document Audit History 

and generate a file
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Web Tab URL Tokens
• Overview

− Web Tab configuration now allows passing a query string or specific query parameters to the 
iFrame page by using tokens in the URL definition

• Configuration
− Admin > Configuration > User Interface > Tabs > Create
− Choose Web under Tab Type

Tokens for query string 
and query parameters
Tokens for query string 
and query parameters
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Flexible DAC mapping
• Overview

− Admins can now configure Dynamic Access Control Matching Rules based on document or object 
fields and user setup fields even if they have different field names, so long as they reference the 
same object or picklist. 

Dropdown displays the object fields 
that reference the same object/picklist 

as the User Role Setup field
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Flexible DAC mapping
• Considerations

− Previously, document and object field names needed to match a User Role Setup field name in 
order to create a Dynamic Access Control (DAC) matching rule

− Best practice is to use consistent field naming

• Use Case
− Various fields on a document, such as Market, Affiliate or Country, reference the Country object. 

Sharing rules can now be created mapping the Country on the User Role Setup object to the 
Affiliate on a document
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Rendition Status
• Overview

− Admins can now view, filter, and troubleshoot document rendering issues by accessing the new 
Rendition Status page from the Operations tab

Results may be sorted by 
clicking the column headers 

Results may be filtered by 
status & Document Number 
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Templates: Hide Inactive
Document Types

• Overview
− The default display for Document and Binder Templates no longer includes inactive templates on 

the Business Admin screen
− Admins will need to click the Show Inactive

button to view inactive templates

Click Show Inactive 
to display templates 

for Inactive types



Vault Loader
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File Staging for Vault Loader CLI
• Overview

− Vault Loader Command Line tool users now 
have the ability to:
• Create, move and delete files and folders on the 

staging server from the CLI utility, empowering 
user to manage Staged areas without the need to 
use API calls

• View directories and files, create new folders, or 
delete existing folders on their vault’s file staging 
server using the Vault Loader CLI 

• Considerations
− Currently customers use FTP when they need 

to import and export large quantities of files or 
to load large files

− May include documents, attachments, 
renditions, etc.

− Additional details can be found here

Remove directory folder1

Move demo_folder under 
the /u4966723 directory

Create demo_folder directory

http://vaulthelp2.vod309.com/wordpress/admin-user-help/vault-loader-file-staging-command-line-tool-reference/
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Vault Loader: 
Bulk Document Attachment Enhancements

• Overview
− Vault Loader now supports the bulk creation and deletion of document attachments
− In addition, this feature adds support for the extraction of document attachment relationships

− To Create document attachments using Loader the CSV file must have these input fields

New Object Type: Document 
Attachments New Action Types: 

Create and Delete
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Vault Loader: 
Bulk Document Attachment Enhancements

• Considerations
− These enhancements apply to version-specific attachments and document level attachments
− To delete document attachments using Loader the CSV file ID field 

• Learn more about managing document attachments with Vault Loader
− Example CSV file with field inputs for Creating document attachments
− Example CSV file with field inputs for Deleting document attachments

http://vaulthelp2.vod309.com/wordpress/admin-user-help/vault-loader-create-delete-document-attachments/
http://developer.veevavault.com/docs/sample-files/vault-create-document-attachments-sample-file.csv
http://developer.veevavault.com/docs/sample-files/vault-delete-document-attachments-sample-file.csv
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Vault Loader: Bulk Object Attachments Support
• Overview

− Vault Loader allows you to bulk create object record attachments if attachments are enabled for 
that object type

− If the attachment already exists, Vault uploads the attachment as a new version of the 
existing attachment

• Use Case
− User uploads content to the Staging Area
− Create supporting CSV
− Go to Loader > Load > Select Object Type > Action Type : Create Attachments
− Optional: Map fields on load CSV to object records
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Vault Loader: Export Usability Enhancements
• Overview

− The Vault Loader Extract UI has been enhanced with preset column selection filters and the 
Where Clause token helper columns/fields values is expanded 

Identify which columns/fields are 
required for a successful load

Identify which columns/fields are related 
to a selected document type

Identify which columns/fields are 
object/outbound relationships

Use the Override Default Column Selection  
checkbox to enable the column selector

Select the token icon to lookup which columns/fields 
are available for use in the Where Clause
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Vault Loader: Export Usability Enhancements
• Considerations

− This enhancement applies to Documents, Document relationships, and Document Versions, VOF 
Objects, and Legacy User extractions

• Learn more about extracting metadata and files with Vault Loader

http://vaulthelp2.vod309.com/wordpress/admin-user-help/admin-vault-loader/vault-loader-extracting-metadata-and-files/
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Vault Loader: Where Clause Validation
• Overview

− The Extract screen for Vault Loader now includes a Validate button to validate query syntax is 
correct prior to initiating an extraction job

− User were not notified of syntax errors until executing the job and reviewing the job failure message

Validate Where Clause 
queries when extracting 
data using Vault Loader 



Objects
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Track User, Machine & Vault File Manager Version
• Overview

− There is a new Standard object called Vault File Manager Users that lets you report on which 
users are using the file manager

• Use Case
− Organizations can leverage this feature to monitor who is logging into Vault File Manager and 

connecting to your Vault

The User, Date Time, and Version of 
Vault File Manager are all recorded



91Copyright © Veeva Systems 2021

Object Lifecycle & Workflow:
Expression Enhancement

• Overview
− Object Lifecycles now supports additional conditions, functions and operators in the Entry Action 

and Event Actions, and the Update Record/Related Record Actions
− Object Workflows now supports additional conditions, functions and operators in the Workflow 

Update Record Field and Update Related Record Field step
− For example,

• Functions such as If and Case
• Operators such as >= (greater than or equal to) and <= (less than or equal to)

• Considerations
− Lookup fields cannot be used in Event actions

• Learn more about expression support in the
Vault Formula Reference Guide

http://vaulthelp2.vod309.com/wordpress/admin-user-help/reference/vault-formula-reference-guide/
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Object Lifecycle & Workflow: 
Expression Enhancement

• Configuration
− Lifecycle

• Admin > Configuration > Object Lifecycle > 
{Lifecycle} > {State} > Entry Action > Edit

• Admin > Configuration > Object Lifecycle > 
{Lifecycle} > {State} > Event Actions > Create 
Record

− Workflows 
• Admin > Configuration > Object Workflows > 

{Workflow} > Edit > Create Step
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Object Lifecycle & Workflow: 
Long Text & Rich Text Fields

• Overview
− Rich Text and Long Text fields on object lifecycle and workflow components
− Vault can update Rich Text and Long Text fields via: 

• Entry actions, such as Update Record Field and Update 
Related Record Field

• Event actions, such as Update Record Field
• Workflow steps, such as Update Record Field and 

Update Related Record Field

Rich Text field as a field prompt 
in a workflow task step

Rich Text field as 
a workflow step
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Object Lifecycle & Workflow: 
Long Text & Rich Text Fields

• Considerations
− Both Rich Text and Long Text fields are available in field prompts for workflow Task steps
− Rich Text fields are also available in action conditions
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Rich Text Fields for Vault Objects
• Overview

− Users can now format the content of field values with Rich Text fields
− Vault supports most common formatting options such as font size, font family, text alignment, 

text decorations, lists, and scientific notation
− Admins can configure Rich Text fields in most places that support text fields

• Use Case 
− Can be used on objects such as Auto Claims records for emphasis
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Show in Tab for Related Document Section
• Overview

− We have renamed the Show in Library link in related document sections of object records to 
Show in Tab

− Clicking on the link opens the list of related documents in a dynamically-generated list of 
related documents

• Considerations
− Previously, the link opened the Library tab. This change resolves an issue where users who did 

not have access to the Library tab were redirected to the Home tab instead

The Show in Tab link 
dynamically generates a 
list of related documents



Object & 
Multi-Document Workflows

Multi-document workflows (MDW) allow you to send one or more 
documents out for review and apprval on a single workflow instance 
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Multi-Document Workflow: Edit Document Fields
• Overview

− Users with appropriate permissions can now edit document fields within the Multi-Document 
Workflow viewer rather than having to open individual documents

• Considerations
− The Edit Fields button is available in both Field View and Mixed View
− Only fields on the document you have selected will be edited

The ‘Edit Fields’ button is now available 
in in the Multi-Document Workflow 
when in Field view and Mixed view 
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Multi-Document Workflow: 
Optional eSignature Manifesting on Documents

• Overview
− Admins can now configure whether 

eSignatures will be manifested on the 
signature page attached to 
downloaded documents in a Multi-
Document Workflow

• Considerations
− ‘Manifest eSignatures’ will be selected 

by default 
• This option can differ between multiple 

verdicts – only the signatures for 
verdicts with ’Manifest eSignature on 
Documents’ enabled are manifested

Admins can now deselect ‘Manifest 
eSignature on document’ 

‘Manifest eSignature 
on document’ will be 

selected by default 
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Multi-Document Workflow: Short Circuit Tasks
• Overview

− Admins can now configure Short Circuit Tasks in Multi-Document Workflows with matching tags
− This feature automatically cancels all pending tasks with a matching tag, including parallel tasks, 

when a short circuit verdict is provided

• Considerations
− Short circuit verdicts can be configured on both single-verdict and multi-verdict tasks on both 

Any Lifecycle and Specific Lifecycle Multi-Document Workflows
− There is no change to Single Document Workflows
− Short-circuiting only cancels TASKS, not the actual workflow, meaning documents will progress 

through the remaining workflow steps

• Use Case
− If a Document has a ‘Rejected’ verdict applied by the Medical Reviewer, this feature allows for 

the Legal and Regulatory tasks to be cancelled automatically. This ensures time is not wasted on 
a task when the document is going back to draft to be revised by the Document Owner anyway
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Multi-Document Workflow: Short Circuit Tasks
• Configuration

− Admin > Configuration > Multi-Document Workflow > [Multi-Document Workflow] > 
Document Task Step 

For example: The legal review task 
will get short-circuited if a task verdict 

with this tag has been applied.

Tags applied to the verdict act 
as the short-circuit trigger.

Tags must be added across all 
Document Tasks in order to allow 

for Short Circuiting on parallel tasks
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Multi-Document Workflow: 
Use Role as Participants

• Overview
− This enhancement to Multi-Document Workflows allows Participant groups to automatically 

select workflow users based on their roles 
• For example, a participant group can consist of users in the Approver role and would mean this automatically 

adds all users who have the Approver role on every document in the workflow as participants in the workflow

• Use Case
− Enables you to use roles to automatically define the list of users in a participant group without 

manual intervention by the workflow initiator

The option to use roles as 
participants in the participant 

control of the start step of 
Multi-Document Workflow
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Multi-Document Workflow: 
Use Role as Participants

• Considerations
− Admins can only select one role per participant group to include
− Vault does not currently support exclusion-based roles
− Users/groups are assigned based on the roles when tasks are created. The user must be in that 

role in every document
− Additional users/groups added after task creation can only be added using ‘Add Participants’ 

and not automatically

• Configuration
− Admin > Configuration > Multi-Document Workflows > [Select Multi-Document Workflow] > 

Start Step > Participants Control
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Inactivate Roles Used in Multi-Document Workflows
• Overview

− Admins can now make Document Lifecycle Roles used in Multi-Document Workflow Start, 
Notification, and Sharing Settings steps inactive

• Considerations
− Once made inactive, the role cannot be used:

• In new participant groups as a constraining role or in 
role-based Participant controls

• As notification recipients or participants when 
updating sharing settings

− There will not be any impact to already existing 
Multi-Document Workflows 

− If the Document Lifecycle Role is used in a 
Document Workflow, it cannot be made inactive

To make a Document 
Lifecycle Role inactive: 
Document Lifecycles > 

[Lifecycle] > Roles > 
[Role] > Status
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Object & Multi-Document Workflow: 
Reassignment Task Event in Update Sharing Settings
• Overview

− Admins can now configure a ‘Task Reassignment From’ Task Event which will add or remove a user 
from a role on document or object sharing settings when the task is reassigned from that user 

• Considerations
− The Task Reassignment From event option updates the sharing settings of the user from which 

the task was reassigned, rather than the current task owner
− Each triggering event can only affect a role once, preventing conflicting rule definitions
− You can only select active roles

• Configuration
− Admin > Multi-Document Workflows > 

[Workflow] > [Workflow Task Step] > Update 
Document Sharing Settings > Add Rule > 
Triggering Event > Select: Reassignment from 
Another User > Operator (Add/Remove) > 
Select Roles (select one or more roles affected 
by the rule)

You can add or 
remove multiple roles
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Object & Multi-Document Workflow: 
Capacity Without Requiring eSignature

• Overview
− This feature allows Admins to configure tasks so that capacity can be provided with a task verdict 

without requiring an eSignature for both Object and Multi-Document Workflows
• Previously it was only possible to provide a capacity with an eSignature

• Use Case
− For documents which do not require                                                                                           

an eSignature the user’s capacity can                                                                                        
be captured within the Task instead

• Considerations
− There can be only one capacity value                                                                                         

for each task completion
− Capacities can be made required 

or optional 

Capacity can be provided 
without requiring an eSignature
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Object & Multi-Document Workflow: 
Capacity Without Requiring eSignature

• Configuration
− MDW: Admin > Configuration > Multi-Document Workflow > [Select Multi-Document Workflow] > 

Document Task > Verdict
− Object: Admin > Configuration > Object Workflow > [Select Object Workflow] > Workflow Task > Verdict

Provide a Capacity label as 
well as Capacity values 
within the task verdict

The option to Add 
Capacities is now 

available within the 
task verdict
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Object & Multi-Document Workflow: 
Replace Workflow Owner

• Overview
− Using a new Replace Workflow Owner action, users with the appropriate permissions can now change 

the workflow owner of an active or in-progress workflow 
• Access to this action is controlled at the user profile level by a new ‘Replace Workflow Owner’ permission

• Considerations
− Workflow ownership can be changed through a workflow action in the Vault UI or by using the API
− The new owner must have the permissions to start the workflow
− When a user replaces the workflow owner, Vault automatically assigns all current and future 

incomplete tasks to the new owner
− The ‘Replace Workflow Owner’ permission by default, is only available to Vault Owners, System Admins 

and Business Admins
− This feature is only available for Object & Multi-Document Workflows

The new Replace Workflow Owner 
action can be found here if the user 

has the required permissions
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Object & Multi-Document Workflow: 
Send Notification Based on Roles

• Overview
− Admins can now configure the notification step for both Object & Multi-Document Workflows to 

send notifications based on roles 
• Prior to 21R1 only participant group notifications were supported in Object & Multi-Document Workflows

• Considerations
− Only one role is allowed per notification step
− Notifications can be sent to Document Owners
− Roles are Lifecycle roles or Application roles depending on Specific Lifecycle or Any Lifecycle 

Multi-Document Workflows
− For Multi-Document Workflows, Vault sends the notification to users who are in that role on every 

document in that workflow
− For Object Workflows, Vault sends the notification to users who are in that role in the object 

record’s sharing settings
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Object & Multi-Document Workflow: 
Send Notification Based on Roles

• Configuration
− Vault Admins will need to select the roles in the recipient dropdown of the Notification Step
− For Multi-Document Workflows: Admin > Multi-Document Workflows > [Select Multi-Document 

Workflow] > Notification Step
− For Object Workflows: Admin > Object Workflows > [Select Object Workflow] > Notification Step

Within the Notification step 
for the Multi-Document 

Workflow, select the Role

Within the Notification step 
for the Object Workflow, 

select the Role
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Object & Multi-Document Workflow: 
Timeline View & Task Bar Enhancements

• Overview
− Verdict details are now available in the Timeline View of a Multi-Document Workflow

• Including, the verdict, comments, reason and capacity
− Vault also now shows task Instructions provided by the Workflow Initiator in the Task Bar for both 

Object and Multi-Document Workflows

Task Instructions are provided 
in the Task Bar for both Object 
& Multi-Document Workflows

The Verdict, Comments, 
Reason and Capacity all now 
show in the Timeline View 
after the task is completed

To see verdicts applied by 
other participants prior to task 
completion you must refer to 
the workflow history report
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Object & Multi-Document Workflow: 
Timeline View & Task Bar Enhancements

• Considerations
− The verdict is shown only after the task is completed 
− Ad-hoc task instructions will be shown in Object & Multi-Document Workflows
− By default, the verdict information table will appear collapsed
− Each document in the MDW will be represented as a separate row in the table
− The table will load up to 10 rows with additional rows loaded on scroll down
− To see verdicts applied by other participants prior to task completion, you must refer to the 

workflow history report
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Object and Multi-Document Workflow: 
Conditional Controls on Start Step

• Overview
− Workflow Admins can now configure Yes/No Boolean expressions on the Workflow Start Step to 

hide the Instructions, Participants, Date, Prompt for Fields, or Variable controls in the Workflow 
Start Dialogue in order to prevent the Workflow Initiator from seeing unnecessary controls

• Considerations
− Only one rule is allowed but you can use different conditions in that rule
− For Multi-Document Workflows, the rule has to be true for each document before for the 

controls to hide
− If a required control is hidden, an error message will be displayed
− This enables the same functionality as the advanced workflow role configuration for single 

document workflows

• Use Case
− If you do not require a Regulatory Reviewer when 

the material is created for Germany, you can 
utilized this feature to hide that Role when starting 
the Multi-Document Workflow
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Object and Multi-Document Workflow: 
Conditional Controls on Start Step

• Configuration
− For Multi-Document Workflows: Admin > Configuration > Multi-Document Workflow > 

[Select Multi-Document Workflow] > Start Step > Start Step Rule > Edit
− For Object Workflows: Admin > Configuration>Object Workflow> [Select Object Workflow] > 

Start Step > Start Step Rule > Edit

Create the Start Step Rule e.g. 
If Document Country equals 
Germany, hide Regulatory 

Reviewers Control

Select ‘Check Syntax’ 
to validate that the 

formular is valid



Resources
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Resources
• Contact your Customer Success Manger or Managed Services Consultant
• Email: VaultCustomerSuccess@veeva.com
• 21R1 Release Kit: https://www.veeva.com/products/commercial-vault-release-

presentations/
• Vault Resource Library: https://support.veeva.com/hc/en-us/articles/360013243773-

Veeva-Vault-Educational-Resource-Library
• Vault Help: http://vaulthelp2.vod309.com/wordpress/

mailto:VaultCustomerSuccess@veeva.com
https://www.veeva.com/products/commercial-vault-release-presentations/
https://support.veeva.com/hc/en-us/articles/360013243773-Veeva-Vault-Educational-Resource-Library
http://vaulthelp2.vod309.com/wordpress/


117Copyright © Veeva Systems 2021



118Copyright © Veeva Systems 2021

21R1 Release Developer Webinar
April 8, 2021 – Register here

Java SDK & Integrations API & VQL Vault Loader

• Notification Template SDK

• Record UI Action Enhancements

• SDK Job Queues

• Deprecate VaultRuntimeException

• User Exception Record Save in Message 
Processors

• API Burst and Daily Limit Changes

• Job API Enhancements

• Workflow API Enhancements

• Log the Global ID in Deleted Document API

• Document ID included in Audit History CSV

• VQL Clause Enhancements

• Rich Text Fields for Vault Objects

• Query Documents with Roles

• Alias Support

• Where Clause Validation

• File Staging Command Line Interface

https://veeva.zoom.us/webinar/register/WN_D4x95U_lRYS4kLGb7dqeoQ


Thank you
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UI Enhancement 
Details

• Vault UI Styling 

• Action Bar 

• Doc Info Page Enhancements

• Notification Badge

• Action Menu Button Change
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Vault UI Style Updates

• More modern look and feel

• Updated visual styling: color, spacing, 
and select icons

• Top banner area visual enhancements 

• Recommended screen resolution: 
1280 x 720 or higher   

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.
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Action Bar

• Quick access buttons to perform each 
user’s own frequently used actions

• A dedicated button to start workflow 
and change lifecycle state 

• Available on Record Details Page and 
Doc Info Page

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.



124Copyright © Veeva Systems 2021

Doc Info Page Enhancements

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.

• Action Bar for Doc Info Page

• Quick access buttons to view and 
manage document

• Resizeable Doc Viewer and Info Panel 

• Simplified and more intuitive 
Annotation toolbar

• Improved viewing and editing of 
annotations
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Notification Badge

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.

• Easily view notification from anywhere 
in Vault

• New notification badge in top banner

• Badge icon updates when new 
notifications arrive

• Navigate directly to new workflow task 
assignments
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Action Menu Button Change

• The Action Menu Button is changing from a gear icon to ellipses icon

• This change is applied throughout Vault UI, except in Admin pages

IMPORTANT: Pre-release features are work-in-progress for informational purposes only. Final released feature may differ from description herein.
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Platform Data Model Changes
• Overview

− Link Annotations to Permalinks feature
• Added the Bookmark Title (bookmark_title__v) field to the Permalink (permalink__sys) object.

− Track User, Machine & Vault File Manager Version feature
• Added the Vault File Manager User (vfm_user__sys) object.

− Checklist: Ad Hoc Questions feature
• Added the Ad Hoc (ad_hoc__v) field to the Response (response__sys) object
• Added the Ad Hoc Questions Allowed (ad_hoc_questions_allowed__sys) field to the Checklist 

Design (checklist_design__sys) object
− Added the Enabled field on the Document Type Detail (doc_type_detail__v) object.
− Added an additional value to the Check Out Types (checkout_types__sys) picklist
− Added additional values to the Link Status (link_status__v) picklist
− Added the Enabled field on the Document Type Detail (doc_type_detail__v) object.
− Added an additional value to the Check Out Types (checkout_types__sys) picklist
− Added additional values to the Link Status (link_status__v) picklist
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Platform Data Model Changes (cont)
• Overview

− Checklist: Ad Hoc Questions feature
• Added the Ad Hoc (ad_hoc__v) field to the Response (response__sys) object
• Added the Ad Hoc Questions Allowed (ad_hoc_questions_allowed__sys) field to the Checklist 

Design (checklist_design__sys) object
− Added the Permission Set field to the Application Roles (application_role__v) object.
− User Role object records can be created, edited, or deleted by a user with the required object 

permissions and the Admin > Security > Users > Manage User Object permission. This object can 
be accessed using the standard Vault object Rest API.
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Commercial Data Model Changes (PromoMats)
• Overview

− Added the following new objects:
• Content Module (content_module__v)
• Content Module Asset (content_module_asset__v) with object 

types Claim (claim__v), Data (data__v), Image (image__v), Text (text__v), and Rule (rule__v)
• Content Module Ruleset (content_module_ruleset__v)
• Promotional Material Information (promotional_material_information__v)
• Ruleset Rule (ruleset_rule__v)

− Added new document field Promotional Material Information
(promotional_material_information__v)

− Added the following new document types:
• Content Module (content_module__v) with subtype Approval Document (approval_document__v)
• Correspondence Letter (correspondence_letter__v)

− Added new multi-document workflow Content Module Approval 
Document (content_module_approval_document__v)

− Added new document lifecycle Content Module Approval 
Document (content_module_approval_document__v)
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Commercial Data Model Changes (PromoMats)
− Added the following new object lifecycles:

• Content Module Asset Lifecycle (content_module_asset_lifecycle__v)
• Content Module Lifecycle (content_module_lifecycle__v)

− Added the following new picklists:
• Rule Type (rule_type__v)
• Text Element Type (text_element_type__v)

− Added the following new notifications:
• Content Module Workflow Approval Task (content_module_workflow_approval_task_v)
• Content Module Task Assigned (content_module_task_assigned_v)
• Content Module State Change Notification (content_module_state_change_notification_v)
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Web Sections for Object Page Layouts
• Overview

− Admins and users will see any web sections added to object page layouts through Metadata 
Definition Language (MDL). Web sections are similar to web tabs and can be used to specify the 
URL of external web content. For example, to display an address’s map location on 
an Organization record

• Learn more about Web Sections in the Developer Portal

https://developer.veevavault.com/mdl/
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Field Default Prompts in Field Rule UI
• Overview

− Admins can configure field rule defaults for Spark integrations with prompts specific to the 
target field
• If the target field is GxP Process? (Yes/No Boolean), Vault prompts for a value of True or False
• If the target field is Complete By (date field), a date selector calendar UI appears

• Considerations
− Previously, field values were entered manually, allowing for invalid data
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Additional Signature Token
• Overview

− With this release we added the Signee Federated ID (signee_federated_id__v) token for 
signatures 

• Learn more about User ID Types

http://vaulthelp2.vod309.com/wordpress/admin-user-help/authentication-vault-security/configuring-oauth-2-oidc-profiles/
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Enhance Compare & Configuration
Report to Provide Warnings

• Overview
− This feature enhances the Vault Compare and Configuration Reports to provide a list of potential 

component and configuration issues in a separate error log for easier troubleshooting. 

• Learn more about Vault Compare and Configuration Reports

http://vaulthelp2.vod309.com/wordpress/admin-user-help/admin-vault-loader/using-vault-compare/
http://vaulthelp2.vod309.com/wordpress/admin-user-help/admin-vault-loader/generate-vault-configuration-report/

